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Introduction 
 
 
 The U.S. Army Engineer Research and Development Center (ERDC) is developing the Army Risk 
Assessment Modeling System (ARAMS) to provide the Army with the capability to perform human and 
ecologically based risk/hazard assessments associated with past practice and current activities at military 
installations.  The intent of the system is to provide a platform from which a variety of assessments can be 
performed.  The system is envisioned to help a risk analyst visualize an assessment from source, through 
multiple environmental media (e.g., groundwater, surface water, air, and land), to sensitive receptors of 
concern (e.g., humans and ecological endpoints).   
 
 ARAMS uses the Framework for Risk Analysis in Multimedia Environmental Systems (FRAMES) 
developed by the Pacific Northwest National Laboratory (PNNL) for linking disparate objects, such as 
environmental fate/transport models, databases, spreadsheets, etc.  FRAMES is a Windows-based 
software platform that provides an interactive user interface and, more importantly, specifications to 
allow a variety of DOS and Windows-based environmental codes to be integrated within a single 
framework.  
 
 This document is intended to serve as a tutorial for helping new users with the application of 
ARAMS/FRAMES and the components within this system.  This example does not include the steps for 
project planning and the use of associated tools under the “File” menu.  These tools help the user plan the 
risk assessment including development of the conceptual site model and the RAGS Part D Table 1 for 
human health risk assessment.  There are several Help files within ARAMS that explain these tools. 
 
 
Example Description 
 
  
 This example (shown schematically in Figure 1) begins with two areas of contaminated soil (Site 1 
and Site 2) and uses the Plus Operator Object to combine the contaminated storm water runoff from both 
sites that feed into another downstream site. Additionally, volatiles from Site 1 are deposited onto the 
downstream site.  The downstream site is modeled with the Secondary Source in Soil Module within the 
Overland Flow Object using the combined runoff and deposited material from the Mepas 4.1 Air Module 
as inputs to calculate a contaminated runoff stream from the land area. The runoff from the Overland 
Flow object flows into a local water body and the Mepas 4.1 River Module is used to calculate the water 
concentration at a downstream extraction point. The water extracted is used for drinking, showering, and 
watering vegetables in a garden. The Exposure Pathways, Receptor Intake, and Health Impacts modules 
are used to determine exposure, uptake, and risk caused by contaminated water and vegetables from the 
garden. 
 
 Site 1, one of the originally contaminated sites, and the secondary site both use the Mepas 4.1 
Source in Soil module to calculate the losses due to resuspension of particles, storm water runoff, and 
leaching. The leaching pathway is not considered for Site 1 due to the presence of a leachate collection 
system, rather leaching is treated as a known sink. The volatilization pathway is not considered for the 
secondary source site. Site 2, the other originally contaminated site, is a sediment trap and uses the WFF 
Overland Flow module to specify the known flux of water and constituents from the sediment trap. The 
constituents chosen for this example are PCB (General Classification) and STRONTIUM-90. 
 
 



 

 
 
Figure 1.  Illustration of the scenario being modeled in this example 



 
 

Figure 2.  Object workspace for example application  
 

 
 

 
 
 
 
 
 
 
 



Input Data 
 

• Double-click on ARAMS icon to open “ARAMS info and Disclaimer” window and then select 
“Accept” to continue. 

 

ARAMS.lnk

 
 
• Choose “FRAMES” in the ARAMS toolbar to launch FRAMES.  (Note: If this is the first time 

you have used ARAMS, you will need to configure it for FRAMES by selecting “File,” then 
“***Must Configure Path to FRAMES***” and supplying the path to the “fui.exe” file). 

 
• While ARAMS/FRAMES is running, click “File” from the FRAMES menu and choose “New.” 

A window titled “Global Input Data Open New” will appear (see Figure 3). In the “File Name” 
box enter the project name (type: “Sample1,” maximum of eight characters) and click “Open” 
(see Figure 4). Do not name the new file “Example8” because it will write over the existing 
“Example8” file that was distributed with the tutorial.  A window titled “Create New Site” 
will appear. Next, type the project site name (type: Secondary Source Example) and click “OK” 
(see Figure 5).  
 

 The color of the workspace may change.  Double-click on the Constituent icon so that the icon 
appears on the upper left corner of the main screen. Repeat this operation to place the following additional 
icons into the workspace: 

 
 

“Source” 
“Air” 
“User-Defined” – for Overland Flow 
“Plus Operators” 
“Overland Flow” 
“Surface Water” 
“Exposure Pathways” 
“Receptor Intake” 
“Health Impacts” 
“Sensitivity” 

 
 Click on and drag each icon to its respective position on the workspace.  Connect the Constituent 
icon and Source icon by holding down SHIFT, clicking on the Constituent icon, dragging the cursor to the 
Source icon, and releasing the mouse button (Note: To remove this line, repeat the steps used to connect 
it.  To remove an icon from the screen, right click and a menu will appear with various options.  Click 
“Delete” and the icon will be taken out.). 

  
In the same fashion, connect the following pairs of icons: 
 

 
  Constituent    → Source (already done) 
  Constituent    → Air 
  Constituent    → User-Defined (Overland Flow)  
  Constituent    → Overland Flow 



  Constituent    → Surface Water 
    Constituent    → Exposure Pathways 
  Constituent    → Receptor Intake 
  Constituent    → Health Impacts 
  Source    → Air 
  Source    → Plus Operators 
  User-Defined (Overland Flow) → Plus Operators 
  Plus Operators   → Overland Flow 
  Air     → Overland Flow 
  Overland Flow   → Surface Water 
  Surface Water   → Exposure Pathways 
  Exposure Pathways   → Receptor Intake 
  Receptor Intake   → Health Impacts 
  Source    → Sensitivity 
  Health Impacts   → Sensitivity 

 
  FRAMES should now look something like Figure 2. 

 

 
 

Figure 3.  Opening a new file 
 



 
 

Figure 4.  Global Input Data Open New screen (new file window) 
 

 

 
 

Figure 5.  Create New Site screen (input “Site name” box) 
 
 

CONSTITUENTS DATABASE MODULE 
 
 Right-click the Constituent icon and choose “General Info” (see Figure 6). When the General Info 
screen opens, enter “Constituent” in the “User Label” text box and select “FRAMES Default Constituent 
Database Selection” in the “Select from applicable models” text box (see Figure 7).  Click OK at the 
bottom of the screen to return to the workspace area.  The Constituent icon’s status indicator will now 
display a red light.   Right-click on the constituent icon in the main screen and choose “User Input.” The 
Constituent Selection screen will open (see Figure 8).  The constituents used in this case are PCB 
(General Classification) and STRONTIUM-90.  Scroll to select the constituents from the constituents list 
or use the Find option to search for them.  Click the “Add >>>” button to add each constituent to the 



selected constituents list.  Select “Save and Exit” from the File menu to return to the workspace screen.  
The Constituent icon’s status light will change from red to green.  

 

 
 

Figure 6. Workspace screen (right-click in the Constituent icon) 
 
 



 
 

Figure 7. Object General Information screen 
 



 
 

Figure 8.  FRAMES Constituent Selection screen (“Constituents of Interest” tab) 
 
 
 The following is a listing of all data input required by the remaining modules used in this example.  
Names of object icons are in bold, italics, and underlined headings.  Menu items (displayed by right-
clicking on the icon) are shown below the module in bold and indented to the right of the icon names.  
Explanations of data required by each menu item are indented further to the right.  To save information 
for your scenario, select “File” and then “Save” from the main FRAMES menu. 
 
 For ease of presentation, the instructions below proceed with selecting module, entering data, running 
the module, and viewing module output.  However, the user should select all object modules prior to 
entering data for each module. 



Source 
 

General Info 
 

A window titled “Object General Information” will appear. Input  “Site 1” in the Label 
text box. Select “Mepas 4.1 Source in Soil” in the section labeled “Select from 
Applicable Models.” Note the northing, easting, and elevation fields at the top left corner 
of the form. These are used to enter the coordinates in three-dimensional space relative to 
a user-defined origin. For this example, Site 1 is assumed to be the origin so these values 
will all be zero. Click the button labeled “OK” to return to the FRAMES workspace. The 
status light next to the Source icon should turn red. 
 

User Input 
 

In the window titled “Source Term Module Input,” enter the information for each of the 
tabs as described below. 
 
• Options Tab (for pathway and simulation settings) – Figure 9 

o Turn off leaching loss route since a leachate collection system is used 
o Set the overland runoff loss route as a known erosion rate 
o Set the volatilization and suspension loss routes as known constituent fluxes 
o Set the known source/sink option to a known constituent flux because the 

values from the leachate collection system will be entered 
o Time interval for the simulation is 1 year 
o Time period for the simulation is 60 years 
o Fraction of residual mass for the simulation is 0.01 

 

 
 
Figure 9.  Source Term Module Input – Options tab 



 
• Waste Zone Tab (soil and other physical properties) – Figure 10 

o Thickness of clean overburden = 0 cm 
o Thickness = 7 m 
o Length = 7 m 
o Width = 5 m 
o Bulk density = 1.855 g/cm3 
o Total porosity = 0.3 
o Moisture content = 0.15 
o Volumetric air content = 0.15 
o Average air temperature = 25˚C 
o Height above ground of local wind measure = 10 m 

 

 
 
Figure 10.  Source Term Module Input – Waste Zone tab 
 

 
• Overland Tab (overland flow data) – Figure 11 

o Discharge of water to overland = 2 m3/yr 
 



 
 
Figure 11.  Source Term Module Input – Overland tab 
 

 
• Kd’s Tab (Soil partitioning parameters) – Figure 12 

o Set the type of equilibrium coefficient to “Select Adsorption Coeff.” and the 
count to “2” for each constituent. This will allow the user to enter values for 
the equilibrium coefficient at two different time points. Other options are 
also available from the dropdown box as shown in Figure 12 (user specified 
values, the value from the constituent database, an estimated value based 
upon soil properties, and a value from a look up table for metals). The value 
is shown first followed by the source of the data such as 228 mL/g from the 
Lookup Table. Enter the following values for the partition coefficients (these 
values are for illustration only; as may be noted, the value for PCB is much 
lower than usual). 
� PCB (General Classification) 

o 1 ml/g at time = 0 years 
o 1 ml/g at time = 60 years 

� STRONTIUM-90 
o 2 ml/g at time = 0 years 
o 2 ml/g at time = 60 years 

� YTTRIUM-90 
o 2 ml/g at time = 0 years 
o 2 ml/g at time = 60 years 

If the Estimated Value option is used, then the user must click the “Soil 
Properties” button and the form shown in Figure 13 will appear.  Values should 
be entered such that they add to 100%.  Note that the type of soil could also be 
chosen from the list at the top right corner of the form. Making a selection from 
this list will automatically fill in the percentage of each component in the soil. 



 

 
 
Figure 12.  Source Term Module Input – Kd’s tab 
 

 
 
Figure 13.  Soil Properties Dialog 

 
• Constituent Properties Tab (Chemical properties and inventory) – Figure 14 

o Enter the following values for the water solubilities 
� PCB (General Classification) – 0.031 mg/L 
� STRONTIUM-90 – 1000000 mg/L 
� YTTRIUM-90 – 1000000 mg/L 



Note that if a value exists for the water solubility for any of these chemicals 
in the FRAMES Constituent Database, as is the case for PCB, it will appear 
in the appropriate box on this form. The values entered here for 
STRONTIUM-90 and YTTRIUM-90 are fictitious and are set to a very large 
number to allow the transport of these constituents to the secondary source 
for illustration of how these radionuclides are handled by the modules used 
in this example.

o Use the “Worksheet” button for each constituent to enter the inventory as 
shown in Figure 15. This is the original amount of material present. The two 
input options available are “Inventory” and “Concentration.” The inventory 
option allows the user to specify the exact mass of the constituent present 
while the concentration option allows the user to specify a concentration of 
the constituent present on a mass of dry soil, mass of wet soil, or volume of 
soil basis. Enter the values given below. 
� PCB (General Classification) – Inventory = 1500 g 
� STRONTIUM-90 – Inventory = 40 Ci 

o Enter the following values for the decay/degradation half-life for each 
constituent. Note that these values will also be filled from the database if 
present. 
� PCB (General Classification) – 43800 days 
� STRONTIUM-90 – 10600 days 
� YTTRIUM-90 – 2.7 days 

o The fraction of volatilization release is used to control volatilization rate at 
constituent level if the user determines that the model-estimated 
volatilization rate is too high. This value is generally set to 1 for most 
constituents and should only be changed if the user has monitoring data that 
can be used to estimate the adjustment required to define this value. 

 
 
 



 
 
Figure 14.  Source Term Module Input – Constituent Properties tab 
 
 

 
 
Figure 15.  Constituent Inventory Worksheet 



 
• Known Media Releases Tab (Known Erosion Rates) – Figure 16 

o Since the overland runoff loss route was set to a known erosion rate, the 
erosion rate must be defined on this tab.  Although the constituent flux to 
suspension will be specified, the erosion rate from suspension must also be 
defined to determine the amount of soil material that is lost through 
suspension. Enter the following values as specified. Once again, values at 
two points in time are specified for each variable. 
� Soil depth lost to water erosion = 2 cm/yr at 0 years 
� Soil depth lost to water erosion = 2 cm/yr at 60 years 
� Wind erosion rate = 1 cm/yr at 0 years 
� Wind erosion rate = 1 cm/yr at 60 years 

 

 
 

Figure 16.  Source Term Module Input – Known Media Releases tab 
 
 

• Known Constituent Flux Tab – Figure 17 
o Since the losses to wind suspension and volatilization were indicated as 

known fluxes on the Options tab they must be entered here.  For this 
example, all values are entered using 4 points in time except for the 
STRONTIUM-90 volatilization flux rate. This rate is zero at all time points 
so only two entries are needed to accurately define this rate with regard to 
time. Enter the following values as shown in Figure 17. 
� Known wind suspension flux rates 

o PCB (General Classification) 
o 0 g/yr at 0 years 
o 1.5 g/yr at 10 years 
o 2.5 g/yr at 40 years 



o 0 g/yr at 60 years 
o STRONTIUM-90 

o 0 Ci/yr at 0 years 
o 3 Ci/yr at 10 years 
o 5 Ci/yr at 40 years 
o 0 Ci/yr at 60 years 

� Known constituent volatilization flux rates 
o PCB (General Classification) 

o 0 g/yr at 0 years 
o 10 g/yr at 10 years 
o 20 g/yr at 40 years 
o 0 g/yr at 60 years 

o STRONTIUM-90 
o 0 Ci/yr at 0 years 
o 0 Ci/yr at 60 years 

o Because there is a leachate collection system, the leaching loss pathway was 
turned off and the known source/sink pathway was set to be a known 
constituent flux. The loss to the leachate collection system will be entered as 
a sink term at the bottom of the “Known Constituent Flux” tab. The values 
entered will be negative to indicate that this is a sink instead of a source. 
Enter the leachate loss values given below and shown in Figure 18. 
� PCB (General Classification) 

o –0.1 g/yr at 0 years 
o –0.1 g/yr at 60 years 

� STRONTIUM-90 
o –0.05 Ci/yr at 0 years 
o –0.05 Ci/yr at 60 years 

 
 
 



 
 
Figure 17.  Source Term Module Input – Known Constituent Flux tab 

 
 
Figure 18.  Source Term Module Input – Known Constituent Flux tab cont. 
 
 



When all of the information on each tab has been entered, select “Save and Exit” from 
the File menu to return to the FRAMES workspace. The status indicator next to the 
Source icon will change to yellow to indicate that the inputs have been entered. 
 

Run Model 
 

The model runs in the background. The status light next to the Source icon should turn 
green. 
 

View/Print Module output 
 

A second menu will appear (see Figure 19). Choose “SCF Graphical View” to view a 
screen output in Excel format (see Figure 20). There are also similar viewers for air flux 
(AFF) and overland water flux (WFF). 
 
 

 
 
Figure 19.  Output Menu for the Mepas 4.1 Source in Soil Module 

 
 



 
 
Figure 20.  Graphical SCF Viewer Output 

User Defined 
 

General Info 
 
A window titled “Object General Information” will appear.  Enter 0.5 for both the 
northing and easting coordinates and –0.005 for the elevation. This indicates that Site 2 is 
0.5 kilometers to the north and east of Site 1 and is 5 meters lower in elevation. In the 
Label text box, input “Site 2.” In “Select from Applicable Models,” choose “WFF 
Overland Flow Module” and click “Ok.”  The status light next to the User Defined icon 
should turn red.  Note that the User Defined icon will now also change to that of an 
Overland Flow object to reflect the type of module that was chosen. 
 

User Input 
 

A window titled “FRAMES User Defined Module” will appear. Enter the data as given 
below and shown in Figure 21 for each constituent. 
 
Width of Flux Plane = 7 m 
Height of Flux Plane = 0.5 m 

 
• Water Flux 

o 5 m3/yr at 0 years 
o 5 m3/yr at 50 years 

 
• PCB (General Classification) Adsorbed Flux 

o 1 g/yr at 0 years 
o 2 g/yr at 10 years 
o 3 g/yr at 20 years 
o 2 g/yr at 30 years 



o 1 g/yr at 40 years 
o 0 g/yr at 50 years 

 
• PCB (General Classification) Dissolved Flux 

o 0.1 g/yr at 0 years 
o 0.2 g/yr at 10 years 
o 0.3 g/yr at 20 years 
o 0.2 g/yr at 30 years 
o 0.1 g/yr at 40 years 
o 0 g/yr at 50 years 

 
• STRONTIUM-90 Adsorbed Flux 

o 0.05 Ci/yr at 0 years 
o 1 Ci/yr at 10 years 
o 0.5 Ci/yr at 20 years 
o 0.1 Ci/yr at 30 years 
o 0.05 Ci/yr at 40 years 
o 0 Ci/yr at 50 years 

 
• STRONTIUM-90 Dissolved Flux 

o 0.002 Ci/yr at 0 years 
o 0.04 Ci/yr at 10 years 
o 0.02 Ci/yr at 20 years 
o 0.004 Ci/yr at 30 years 
o 0.002 Ci/yr at 40 years 
o 0 Ci/yr at 50 years 

 
Choose  “Save and Exit” from the File menu to return to the FRAMES work space.  The 
status light next to the User Defined icon should turn yellow. 
 



 
 
Figure 21.  WFF Overland Flow Module Input screen 
 
 

Run Model 
 

The model runs in the background.  The status light next to the User Defined icon should 
turn green.   
 

View/Print Module output 
 

A second menu will appear. Choose “WFF Graphical View” to view a screen output in 
Excel format (see Figure 22). 
 



 
 
Figure 22.  Graphical WFF Viewer Output 
 
 

Plus Operators 
 

General Info 
 
A window titled “Object General Information” will appear. The Plus Operator is assumed 
to be at the same location as the Secondary Source since this is where the two overland 
runoff streams will combine to contaminate the Secondary Source. Enter 0.5 for the 
easting coordinate, 0 for the northing coordinate, and –0.01 for the elevation. In the Label 
text box, input “Plus Operator.” In “Select from Applicable Models,” choose “WFF 
Overland Plus Operator” and click “Ok.”  The status light next to the Plus Operators icon 
should turn red. 
 

User Input 
 
The Plus Operators object does not require any user input since it is simply taking the 
output from two upstream modules and combining them to produce a single output file. 
In this case a Water Flux File (WFF) will be produced, which is the sum of runoff from 
Site 1 and Site 2. 
 

Run Model 
 

The model runs in the background.  The status light next to the Plus Operators icon 
should turn green.   
 



View/Print Module output 
 

A second menu will appear. Choose “WFF Graphical View” to view a screen output in 
Excel format (see Figure 22). The output from this module will be the sum of the outputs 
from the Mepas 4.1 Source in Soil (Site 1) and the WFF Overland Flow (Site 2) modules. 
 
 

 
 
Figure 22.  Graphical WFF Viewer Output 

 
 

Air 
 

General Info 
 
The Air module will simulate the transport of material from Site 1 to other locations, 
including the secondary source site.  A window titled “Object General Information” will 
appear. The origin of the air model is assumed to be coincident with the origin of this 
scenario and Site 1, so it will have the same coordinates and elevation as Site 1, which is 
the origin. In the Label text box, input “Air.” In “Select from Applicable Models,” choose 
“Mepas 4.1 Air Module” and click “Ok.” The status light next to the Air icon should turn 
red. 
 

User Input 
 
A screen titled “Mepas Atmospheric Module” will appear. There are three main tabs 
containing fields that must be filled by the user. Enter the information for each tab as 
given below. For further information on any of these fields, select “How to …” from the 
Help menu or press the F1 key to go directly to the information for the current field. 
 



• The first tab labeled “Climatology” is shown in Figure 23 and contains general 
climatological data.  

 
o Reference Weather Station – identifier of the weather station where the data 

was obtained (this field is not required and may be left blank) 
o Morning mixing height = 400 m 
o Afternoon mixing height = 900 m 
o Annual precipitation = 10 in 
o Precipitation days per year = 70 
o Thunderstorms per year = 25 

 

 
 
Figure 23.  Mepas Atmospheric Module – Climatology tab 

 
 
• The second tab is the “Joint Frequency Data” tab shown in Figure 24. This tab will be 

used to input data pertaining to the relative frequencies of various wind conditions for 
the area surrounding the current site. There are eight tabs under the Joint Frequency 
Data section. The tab labeled “General” is used to enter general information 
pertaining to the frequency data. The other seven tabs labeled “Class A” through 
“Class G” contain tables for entering information about each of these wind stability 
classes. Wind frequency data can be obtained through the STAR PROGRAM 
summaries from the National Climatic Data Center (NCDC) in Asheville, North 
Carolina, which is operated by the National Oceanic and Atmospheric Administration 
(NOAA's) Environmental Data Service. A file containing frequency data will be 
imported and used to fill the tables in this example. Click the button labeled “Import 
Joint Frequency Data” at the bottom of the “General” tab. Select the file titled 



“JFData.jfd” from the FRAMES directory as shown in Figure 25 and select “OK.” 
The data for the “Wind joint frequency calms” section on the “General” tab will be 
filled in along with the tables for the wind stability classes on the remaining tabs. 
Enter the additional data given below on the “General” tab as shown in Figure 24. 

 
o Anemonometer height = 10 m 
o Average roughness length = 2 cm 
o Wind speed midpoints 

o Group 1 = 0 m/s 
o Group 2 = 2 m/s 
o Group 3 = 3 m/s 
o Group 4 = 4 m/s 
o Group 5 = 5 m/s 
o Group 6 = 6 m/s 

 

 
 
Figure 24.  Mepas Atmospheric Module – Joint Frequency Data tab 
 
 



 
 
Figure 25.  Selection of a Joint Frequency Data File for Importing 
 
 

• The last tab is labeled “Topographical Data” and is used to enter information for 
elevated releases or information about the topography of the site if the terrain will be 
assumed to influence the atmospheric movements. For this example the default 
values will be used as shown in Figure 26 so no further input is required. Select 
“Save and Exit” from the File menu to return to the FRAMES work space. The status 
light next to the Air icon should turn yellow. 

 



 
 
Figure 26.  Mepas Atmospheric Module – Topographical Data tab 

 
 

Run Model 
 

The model runs in the background.  The status light next to the Air icon should turn 
green.   
 

View/Print Module output 
 

A second menu will appear. Choose “GNUPLOT ATO Concentrations” to view a three-
dimensional plot of the constituent concentrations and deposition rates in the atmosphere 
around the current site. A dialog will appear prompting the user for the center coordinate 
for both northing and easting as well as the time span and time interval for the graphs that 
will be created (see Figure 27). Accept the default values and click the “Convert” button 
to load the first graph. This viewer will produce plots of the constituent concentrations in 
air as well as deposition rates as shown in Figures 28 and 29, respectively. 
 



 
 
Figure 27.  GNUPLOT ATO Converter Dialog 
 
 

 
 
Figure 28.  Plot of PCB concentrations in the air at Site 1 after 6 years 
 
 



 
 
Figure 29.  Plot of PCB deposition rates at Site 1 after 6 years 
 
 

Overland Flow 
 

General Info 
 

A window titled “Object General Information” will appear. Enter 0.5 for the easting 
coordinate, 0 for the northing coordinate, and –0.01 for the elevation.  The location can 
affect how much deposition from air is received from the air model.  In the Label text 
box, input “Secondary Source.” In “Select from Applicable Models,” choose “Copy of 
Mepas 4.1 Secondary Source in Soil” and click “Ok.” The status light next to the 
Overland Flow icon should turn red. 

 
User Input 

 
Since this module is a copy of the Mepas 4.1 Secondary Source in Soil, the module and 
the inputs are similar to those explained for the Mepas 4.1 Source in Soil module that was 
used to model Site 1. The main difference in the Secondary Source module is that the 
source/sink terms are automatically set to use the Secondary Sources from the Plus 
Operator and Mepas 4.1 Air Module as shown in Figure 30. Enter the data for each tab as 
given below. 
 
• Options Tab (for pathway and simulation settings) – Figure 30 

o Turn off the leaching loss route 
o Set the overland runoff loss route as a known erosion rate 
o Set the suspension loss route to be computed 
o Turn off the volatilization loss route 



o Time period for the simulation is 210 years 
o Fraction of residual mass for the simulation is 0.01 

 

 
 
Figure 30.  Source Term Module Input – Options tab 
 
 

• Waste Zone Tab (soil and other physical properties) – Figure 31 
o Thickness of clean overburden = 0 cm 
o Thickness = 5 m 
o Length = 200 m 
o Width = 100 m 
o Bulk density = 1.4 g/cm3 
o Total porosity = 0.4 
o Moisture content = 0.2 
o Average air temperature = 25˚C 
o Height above ground of local wind measure = 10 m 
o Since the “Compute pathway” option was selected for the suspension 

pathway, the mean annual wind speed is required. Set this value to 10 mi/hr. 
 



 
 
Figure 31.  Source Term Module Input – Waste Zone tab 
 
 

• Overland Tab (overland flow data) 
o Discharge of water to overland = 5 m3/yr 

 
• Suspension Tab (data for calculating particle suspension) – Figure 32 

o The suspension model used in the Mepas 4.1 Secondary Source in Soil 
module is based on a 1985 report by Chatten Cowherd of the Midwest 
Research Institute prepared for the EPA Office of Health and Environmental 
Assessment. Enter the following data on the suspension tab. 
� Dry bulk density of surface soil = 1.65 g/cm3 
� Fraction of non-erodable surface cover is between 0 and 1% 
� Surface roughness length = 0.6 cm 
� Surface area covered with vegetation = 0.7 (fraction) 
� Surface area covered with a crust layer = 0.2 (fraction) 
� Area-weighted disturbance frequency = 1 per month 
� Fastest mile wind speed = 60 mi/hr 
� Thornwaite’s precipitation-evaporation index = 100 
� Aggregate size distribution = 0.6 mm 
� No roadway travel at the site 



 
 
Figure 32.  Source Term Module Input – Suspension tab 
 
 

• Kd’s Tab (Soil partitioning parameters) 
o Accept the default settings of “Select Adsorption Coeff.” and a count of “2” 

for each constituent. Enter the following values for the partition coefficients. 
� PCB (General Classification) 

o 0 ml/g at time = 0 years 
o 0 ml/g at time = 210 years 

� STRONTIUM-90 
o 0.1 ml/g at time = 0 years 
o 0.1 ml/g at time = 210 years 

� YTTRIUM-90 
o 0.1 ml/g at time = 0 years 
o 0.1 ml/g at time = 210 years 

 
• Constituent Properties Tab (Chemical properties and inventory) 

o Enter the following values for the water solubilities. These are the same 
values as seen in the Source object description above. 
� PCB (General Classification) – 0.031 mg/L 
� STRONTIUM-90 – 1000000 mg/L 
� YTTRIUM-90 – 1000000 mg/L 
 

o Use the “Worksheet” button for each constituent to enter the inventory as 
given below. The inventory cannot be set to zero so it is set to a small 
number in this example to show that the loading is coming from the other 
sources. 
� PCB (General Classification) – Inventory = 0.1 g 



� STRONTIUM-90 – Inventory = 0.1 Ci 
 

o Enter the following values for the decay/degradation half-life for each 
constituent. Note that these values will also be filled from the database if 
present. These are the same values from the Source object description above. 
� PCB (General Classification) – 43800 days 
� STRONTIUM-90 – 10600 days 
� YTTRIUM-90 – 2.7 days 
 

o The fraction of volatilization release is not enabled because this pathway was 
turned off on the Options tab. 

 
• Known Media Releases Tab (Known Erosion Rates) 

o Enter the following values as specified. 
� Soil depth lost to water erosion = 5 cm/yr at 0 years 
� Soil depth lost to water erosion = 5 cm/yr at 210 years 

 
When all of the information on each tab has been entered, select “Save and Exit” from 
the File menu to return to the FRAMES work space. The status indicator next to the 
Overland Flow icon will change to yellow to indicate that the inputs have been entered. 
 

Run Model 
 

The model runs in the background. The status light next to the Overland Flow icon 
should turn green. 
 

View/Print Module output 
 

A second menu will appear. Choose “WFF Graphical View” to view a screen output in 
Excel format (see Figure 33).   
 
 



 
 
Figure 33.  Graphical WFF Viewer Output 
 
 

Surface Water 
 

General Info 
 

A window titled “Object General Information” will appear. Enter 0.5 for the easting 
coordinate, –0.5 for the northing coordinate, and –0.015 for the elevation. However, the 
location of the surface water object does not matter for this example since the MEPAS 
4.1 River Module does not accept air deposition. In the Label text box, input “Surface 
Water.” In “Select from Applicable Models,” choose “Mepas 4.1 River Module” and 
click “Ok.” The status light next to the Surface Water icon should turn red. 

 
User Input 
 

A window titled “Mepas River Module” will appear (Figure 34). Enter the data as given 
below for each tab. 
 

• Dimensions Tab (physical properties of the river) – Figure 34 
o Flow velocity at constituent entry point = 2.5 ft/s 
o Depth at constituent entry point = 2 ft 
o Width at constituent entry point = 20 ft 
 
o There is only one Exposure Pathways object so the usage location is 

automatically set to this object. Enter the properties given for the river at 
the usage location. 

 
� Distance from source (entry point)  to (exposure) location = 500 

m 



� Average annual discharge at location = 100 ft3/s 

 
 
Figure 34.  Mepas River Module – Dimensions tab 
 
 
• Constituent Properties Tab (chemical properties for each constituent) – Figure 35 

o PCB (General Classification) 
� Water solubility = 0.031 mg/L 
� Half-life in surface water = 20 yr 

o STRONTIUM-90 
� Water solubility = 1000000 mg/L 
� Half-life in surface water = 10600 days 

o YTTRIUM-90 
� Water solubility = 1000000 mg/L 
� Half-life in surface water = 2.7 days 

 
When all of the information on each tab has been entered, select “Save and Exit” from 
the File menu to return to the FRAMES work space. The status indicator next to the 
Surface Water icon will change to yellow to indicate that the inputs have been entered. 
 



 
 
Figure 35.  Mepas River Module – Constituent Properties tab 
 

 
Run Model 
 

The model runs in the background. The status light next to the Overland Flow icon 
should turn green. 

 
View/Print Module Output 
 

A second menu will appear. Choose “WCF Graphical View” to view a screen output in 
Excel format (see Figure 36). 
 



 
 
Figure 36.  WCF graphical viewer output 
 
 

Exposure Pathways 
 

General Info 
 

The Exposure Pathways object has been discussed in other tutorials and will be 
mentioned only briefly here. Enter 0.5 for the easting coordinate, -1 for the northing 
coordinate, and –0.02 for the elevation.  However, the locations don’t matter for this 
example since the exposure location was set in the river module.  In the Label text box, 
input “Exposure Pathway.” In “Select from Applicable Models,” choose “Mepas 4.1 
Chronic Exposure Module” and click “Ok.” The status light next to the Exposure 
Pathways icon should turn red. 

 
User Input 
 

Enter the data given for each of the tabs on the Mepas Chronic Exposure Module screen. 
 

• Surface Water Tab 
o Pathways Tab 

� Exposure duration = 30 yr 
� Select “Leafy vegetables,” “Drinking water,” and “Shower 

water” as the pathways to be considered 
o Water Usage Tab (default values are used) 

� Fraction of year that surface water is used for irrigation = 1 
� Irrigation rate = 100 L/m2/month 
� Domestic water distribution time = 0.5 days 
� Domestic water is not treated 



o Recreational tab (no pathways are considered that would affect data on 
this tab) 

• Exposure Controls Tab 
o Time to start exposure computation = 0 yr 
o Maximum time for reporting = 210 yr 
o Number of time points for evaluation = 20 

• Leach Rates Tab (leach rates are set to low values to simulate a worst case 
scenario where leaching losses are minimal) 

o Leachate selection option = “User provided leach rate constants” 
o Surface soil leach rate constant 

� PCB (General Classification) = 0.05/yr 
� STRONTIUM-90 = 0.05/yr 
� YTTRIUM-90 = 0.05/yr 

• Constituent Parameters Tab 
o Half-life in surface water 

� PCB (General Classification) = 20 yr 
� STRONTIUM-90 = 10600 days 
� YTTRIUM-90 = 2.7 days 

 
Changes can also be made to other parameters such as Animal Intake Rates, Feed and 
Water Contamination, etc. by selecting “Customize” from the menu. Default values were 
used for this example. Choose “Save and Exit” from the File menu. The status indicator 
next to the Exposure Pathways icon should turn yellow. 
 

Run Model 
 

The model runs in the background. The status light next to the Exposure Pathways icon 
should turn green. 

 
View/Print Module Output 
 

Refer to Example 4 for a sample of output data from the Exposure Pathways object. 
 
 

Receptor Intake 
 

General Info 
 

The Receptor Intake object has been discussed in other tutorials and will be mentioned 
only briefly here.  In the Label text box, input “Receptor Intake.” In “Select from 
Applicable Models,” choose “Mepas 4.1 Intake Module” and click “Ok.” The status light 
next to the Receptor Intake icon should turn red. 

 
User Input 
 

Enter the data given below. All default values are used for this example. 
 

• Body weight of individual = 70 kg 
• Exposure duration = 30 yr 
• Water dermal absorption model = “EPA model” 



• Ground water ingestion rate = 2 L/day 
• Surface water ingestion rate = 2 L/day 
• Age of receptor at start of exposure = 0 yr 
• Age of receptor at end of exposure = 70 yr 
• Method for inhalation impact analysis = “Air concentration” 

 
Additional parameters may be modified by selecting “Customize” from the menu. 
However, all default values for this module were used for this example as stated earlier. 
Choose “Save and Exit” from the File menu. The status indicator next to the Receptor 
Intake icon should turn yellow. 

 
Run Model 
 

The model runs in the background. The status light next to the Receptor Intake icon 
should turn green. 

 
View/Print Module Output 
 

Refer to Example 4 for a sample of output data from the Receptor Intake object. 
 

 
Health Impacts 
 

General Info 
 

The Health Impacts object has been discussed in other tutorials and will be mentioned 
only briefly here.  In the Label text box, input  “Health Impacts.” In “Select from 
Applicable Models,” choose “Mepas 4.1 Human Health Impact Module” and click “Ok.” 
The status light next to the Health Impacts icon should turn red. 

 
User Input 
 

Enter the data given below. All default values are used for this example. 
 

• Chemical Tab 
o Calculate lifetime cancer incidence = True 
o Calculate hazard index = True 

o Hazard quotient threshold limit = 0 
o Method for inhalation impact analysis = “Air concentration” 

 
• Radionuclide Tab 

o Calculate lifetime cancer incidence = True 
o Conversion factor = 0.06 

o Cancer risk evaluation method = “ICRP dose and risk factors” 
o Thickness of contaminated soil/sediment layer = 0.04 m 
o Density of contaminated soil/sediment layer = 1.5 g/cm3 

 
Choose “Save and Exit” from the File menu. The status indicator next to the Health 
Impacts icon should turn yellow. 
 



Run Model 
 

The model runs in the background. The status light next to the Health Impacts icon 
should turn green. 

 
View/Print Module Output 
 

A second menu will appear. Choose “Summary Views of Risk, Hazard and Dose” to 
view the screen shown in Figure 37. This viewer shows summary data and totals for the 
exposure pathways that were chosen. The user can select options such as the location, 
exposure medium, constituent and time point to determine the data that are shown. 
 

 
 
Figure 37.  Summary Viewer for Health Impacts Module 
 
 

Sensitivity 
 

General Info 
 

The Health Impacts object has been discussed in other tutorials and will be mentioned 
only briefly here. In the Label text box, input “Uncertainty.” In “Select from Applicable 
Models,” choose “Mepas Sensitivity/Uncertainty” and click “Ok.” The status light next to 
the Sensitivity icon should turn red. 

 



User Input 
 

The variables and outputs that were considered uncertain in this example are listed below. 
For more information on the Sensitivity object refer to Example 4. 
 
• Variables 

o Wind suspension flux rates at Site 1 
� PCB (General Classification) at times 0, 10, 40 and 60 years 
� STRONTIUM-90 at times 0, 10, 40 and 60 years 

o Water erosion rates at Site 1 at times 0 and 60 years 
 

• Output Parameters 
o Total constituent flux peak for PCB (General Classification) at Site 1 
o Carcinogenic risk peak for PCB (General Classification) 

 
Run Model 
 

The model runs in the background. The status light next to the Health Impacts icon 
should turn green. 

 
View/Print Module Output 
 

An example of output from the Sensitivity/Uncertainty Module is shown in Figure 38 for 
PCB peak carcinogenic risk probability of exceedence.   
 

 
 
Figure 38.  Output from Sensitivity/Uncertainty Module viewer for PCB peak 
carcinogenic risk 
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